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Copyright © 2020 - Arcoptix. 

All rights reserved. No part of this publication may be reproduced, stored in a retrieval 
system, or transmitted, by any means, electronic, mechanical, photocopying, 
recording, or otherwise, without written permission from Arcoptix.  

This manual is sold as part of an order and subject to the condition that it shall not, by 
way of trade or otherwise, be lent, re-sold, hired out or otherwise circulated without the 
prior consent of Arcoptix in any form of binding or cover other than that in which it is 
published.  

 

Trademarks  

All products and services herein are the trademarks, service marks, registered 
trademarks or registered service marks of their respective owners.  

 

Limits of Liability  

Every effort has been made to make this manual as complete and as accurate as 
possible, but no warranty or fitness is implied. The information provided is on an “as 
is” basis. Arcoptix shall have neither liability nor responsibility to any person or entity 
with respect to any loss or damages arising from the information contained in this 
manual. 

The instruments are often customized, and they undergo a very dynamic 
development, therefore the information contained in this document may 
partly become obsolete without any notice. Arcoptix will appreciate your 
tolerance in such cases and we are committed to provide any relevant 
information to assure your full satisfaction with the product.  
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Warranty 
 
This product is covered by a limited warranty. Using the equipment in a manner not 
specified by this manual may impair the protection provided by the equipment. 
Information in this document is subject to change without notice and does not represent 
a commitment on the part of Arcoptix S.A. No responsibility is assumed by Arcoptix 
S.A. for the use of this software, hardware or other rights of third parties resulting from 
its use. The software described in this document is furnished under a license 
agreement and may be used or copied only in accordance with the terms of the 
agreement. The user may make a single copy of the software for archival purposes.  

 

A limited warranty of 1 year is given. It starts 30 days after purchasing the 
spectrometer.  

 

Arcoptix S.A. (Arcoptix or Seller) warrants that its products will be free from defects in 
materials and workmanship under normal use and service in general process 
conditions for the effective period set out below. This warranty and its remedies are in 
lieu of all other warranties expressed or implied, oral or written, either in fact or by 
operation of law, statutory or otherwise, including warranties of merchantability and 
fitness for a particular purpose, which Arcoptix specifically disclaims. Arcoptix shall 
have no liability for incidental or consequential damages of any kind arising out of the 
sale, installation, or use of its products. Arcoptix’s obligation under this warranty shall 
not arise until Buyer notifies Arcoptix of the defect. Arcoptix’s sole responsibility under 
this warranty is, at its option, to replace or repair any defective component part of the 
product within the warranty period. Except in the case of an authorized distributor or 
seller, authorized in writing by Seller to extend this warranty to the distributor’s 
customers, the warranty herein applies only to Buyer as the original purchaser from 
Seller and may not be assigned, sold, or otherwise transferred to a third party. No 
warranty is made with respect to used, reconstructed, refurbished, or previously owned 
Products, which will be so marked on the sales order and will be sold “As Is”.  

 

BUYER’S SOLE AND EXCLUSIVE REMEDY UNDER THIS WARRANTY IS THAT 
THE SELLER EITHER AGREES TO REPAIR OR REPLACE, AT SELLER’S SOLE 
OPTION, ANY PART OR PARTS OF SUCH PRODUCTS THAT UNDER PROPER 
AND NORMAL CONDITIONS OF USE, PROVE(S) TO BE DEFECTIVE WITHIN THE 
APPLICABLE WARRANTY PERIOD. ALTERNATELY, SELLER MAY AT ANY TIME, 
IN ITS SOLE DISCRETION, ELECT TO DISCHARGE ITS WARRANTY OBLIGATION 
HEREUNDER BY ACCEPTING THE RETURN OF ANY DEFECTIVE PRODUCT 
PURSUANT TO THE TERMS SET FORTH HEREIN AND REFUNDING THE 
PURCHASE PRICE PAID BY BUYER.  
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Place of Service 

Seller shall use its best efforts to assist buyer to resolve all warranty related issues 
through Arcoptix customer and technical support as soon as reasonably practicable 
after notification by the Buyer of a possible defect. However, the Seller reserves the 
right to require the Buyer return the Product to Seller’s production facility, 
transportation charges prepaid, when necessary, to provide proper warranty service. 

 

Effective Date 

The effective date of this warranty shall begin on the date of shipment/date of invoice, 
whichever is later. Products are warranted to be free from defects in materials and 
workmanship for parts and labor for 1 year with the exceptions indicated below: 

 

Limitations 

Products are warranted to be free from defects in materials and workmanship for parts 
and labor for 1 year with the following exceptions:  

 Any components of the system that are in direct contact with corrosive 
materials are warranted to be free from defects in materials and workmanship 
at time of delivery but cannot be further warranted due to the unknown nature 
of the use of the product. 

 Consumable items such as lamps, cuvettes and optical filters are excluded 
from this warranty. If a lamp undergoes a catastrophic failure (e.g., no light at 
all) within 90 days of shipment from the factory, it will be replaced at no charge. 

 Loss, damage, or defects resulting from transportation to the Buyer’s facility, 
improper or inadequate maintenance by Buyer, software or interfaces supplied 
by the buyer, unauthorized modification or operation outside the environmental 
specifications for the instrument, use by unauthorized or untrained personnel 
or improper site maintenance or preparation.  

 The sole and exclusive warranty applicable to software and firmware products 
provided by Seller for use with a processor internal or external to the Product 
will be as follows: Seller warrants that such software and firmware will conform 
to Seller’s program manuals or other publicly available documentation made 
available by Seller current at the time of shipment to Buyer when properly 
installed on that processor, provided however that Seller does not warrant the 
operation of the processor or software or firmware will be uninterrupted or error 
free.  

 Products that have been altered or repaired by individuals other than Arcoptix 
personnel or its duly authorized representatives, unless the alteration or repair 
has been performed by an authorized factory trained service technician in 
accordance with written procedures supplied by Arcoptix.  

 Products that have been subject to misuse, neglect, accident, or improper 
installation.  
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The warranty herein applies only to Products within the country of original delivery. 
Products transferred outside the country of original delivery, either by the Seller at the 
direction of the Buyer or by Buyer’s actions subsequent to delivery, may be subject to 
additional charges prior to warranty repair or replacement of such Products based on 
the actual location of such Products and Seller’s warranty and/or service surcharges 
for such location(s).  

 

The warranty period for data processing equipment, including data storage devices, 
processors, printers, terminals, communication interfaces, tape drives, and/or all 
similar devices, is in all cases limited to ninety (90) days from the date of shipment to 
Buyer. 

 

Repaired products are warranted for 90 days with the above exceptions. 



 - 8 - 

  Arcoptix S.A.  

 Introduction  

1.1  Product description 
The ARCspectro FT ROCKET is a family of near-infrared (NIR) and mid-infrared (MIR) 
scanning Fourier-transform (FT) spectrometers. They are high precision opto-
mechanical devices combining optics, micromechanical actuation and electronics.  At 
the heart of the FT ROCKET spectrometers is a white-light interferometer, whose 
motion is measured with extreme precision by a solid-state reference laser. Dedicated 
optical components bring the light through the interferometer mirrors to the detector. 

The spectrometers are packaged in a friendly housing, including all necessary 
electronics with the A/D converter and the USB data transfer, shown in Figure 1-1: 

 
Figure 1-1 The Fourier-transform spectrometer FT-NIR Rocket. One distinguishes the input 
connector for the optical fiber, bringing the light into the spectrometer. Data transfer to the 

computer and power supply (for non-cooled detectors) are done by the USB connection. 

 

The ARCspectro FT ROCKET family of fibered spectrometers includes : 

 FT-NIR ROCKET: covers a wavelength range of 0.9-2.6 micrometers with 
InGaAs photodiodes (uncooled or thermoelectrically cooled versions). It can be 
coupled via low –OH content NIR fibersand many commerciall available NIR 
sampling accessories. 

 FT-MIR ROCKET: covers a wavelength range of 2.0-6.0 micrometers with 
thermoelectrically cooled MCT detectors. It can be used with commercially 
available Chalcogenide MIR fibers and MIR sampling accessories. 

 FT-IR ROCKET (OEM) ARCoptix also commercializes free-space (non-
fibered) versions of the FT Rocket for OEM applications, with wavelength 
ranges covering up to 2-12 micrometers using thermoelectrically cooled MCT 
detectors (wave-number range 830-5000 cm-1). Please contact ARCoptix for 
further information. 

 GASEX and GASEX PORTA MIR spectrometers coupled to a Gas  cell 
designed for gas mixtures analysis. 
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1.2 Principle of operation  
The heart of the FT-Rocket is dual retro-reflector interferometer, schematized in Figure 
1-2.  The two retro-reflectors are solidary to a common swinging arm, which rotates to 
create an optical path difference in the two arms of the interferometer. 

 

Figure 1-2 - The principle of operation of the FT Rocket interferometer 

This type of design is called a permanentely aligned interferometer, as the alignment 
of the system know to be the most rubust against vibrations and temperature drifts. It 
never has to be realigned. 

 
The swinging arm of the interferometer rotates on wear-free flexture system, making 
this mechanical system extremely robust and long-lifed. 

 

When monochromatic light enters an ideal interferometer, the signal recorded at the 
detectors has the form: 

𝐼(𝛿) = 𝐼଴𝑅஻ௌ𝑇஻ௌ ൤1 + m cos
2𝜋

𝜆
𝛿൨ 

where 𝐼଴ is the intensity of the light entering the interferometer,  𝑅஻ௌ  and 𝑇஻ௌ  are the 
beam splitter reflectivity and transmission, m is called the modulation coefficient (which 
is close to 1). It is a sinusoidal function of the optical path difference 𝛿, whose period is 
dependent on the wavelength of light. 

The AC component of 𝐼(𝛿)  is called the interferogram. Very basically, if the light 

entering the interferometer is composed by a continuous spectrum 𝑆(𝜐), where 𝜐 =
ଵ

ఒ
 is 

called the light wave number, Then the recorded interferogram is the integral over all wave 
numbers 𝜐: 

𝐼஺஼(𝛿) = න 𝑆(𝜐)m cos (2𝜋𝜐𝛿)𝑑𝜆
ାஶ

ିஶ
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The recorded interferogram 𝐼஺஼(𝛿)  contains all information about the spectral 
composition 𝑆(λ) of the incoming light, which can be extracted by using mathematical 
operation called a Fourier transformation: 

𝑆(𝜐) = න 𝐼஺஼(𝛿) m cos (2𝜋𝜐𝛿)𝑑𝛿
ାஶ

ିஶ

 

 

1.3 System requirements 
The spectrometer connects to a notebook or desktop PC via a USB 2.0 port. 
Spectrometers also require an additional external 12V DC power supply. The optics, 
mechanics and electronics share the same single housing.  

The Arcspectro FT ROCKET can connect via the USB 2.0 (or USB 3.0) port to any PC 
that uses a Windows 64 bits 7 or 10 operating system and has the spectrometer 
operating software installed and configured for use with your Arcspectro FT ROCKET.  

An EEPROM memory chip in each Arcspectro FT ROCKET spectrometer contains 
calibration parameters and the serial number unique to each spectrometer. The 
operating software reads these values from the spectrometer.  

The Arcspectro FT Rocket has two or three input connectors, depending on the 
version: 

 one FSMA receptacle which accepts a fiber optic cable with a standard SMA-
905 connector 

 one USB port which connects to a USB host (computer) via a standard USB 
cable 

 one connector for the external for a 12V  power supply  
 Optionally on Gasex porta devices an ethernet connector. 

 

1.4 Items Included with the shipment  
Important information and documentation accompany your Arcspectro FT ROCKET 
spectrometer upon shipment. This includes:  

 Software and manual USB key – Each spectrometer order comes with 
Arcoptix software CD. This disc contains all Arcoptix software and manuals for 
software operation. Documentation is provided in Portable Document Format 
(PDF). You need Adobe Acrobat Reader to view these files. 

 USB cable  
 12V DC Power supply (not with USB-powered spectrometer versions) 
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  Installing the Arcspectro FT spectrometer 

2.1 General information 
 
Important: You must install the operating software application prior to connecting the 
Arcspectro FT ROCKET spectrometer to the PC. 

The Arcspectro spectrometer operating software installs the drivers required for 
Windows to communicate with the Arcspectro FT ROCKET. If you do not install the 
software first, the system might not properly recognize the Arcspectro FT ROCKET. 

Follow the steps in this section to interface the Arcspectro FT ROCKET Spectrometer 
via the USB port to a desktop or notebook PC.  

To connect the FT ROCKET Spectrometer to a PC via the USB port, the PC must be 
running windows 7/10 64 bits operating system. You must have administrator 
privileges in order to run the installation package. 

 

2.2 Software Installation 
The setup is a semi-automated procedure including the following installation stages: 

 Detection and installation of eventual missing packages like 2013 or 
2015-2019 C++ redistributable packages. 

 Installation of the main software 
 Installation of the device drivers 
 Connection of the device to the computer. 

 

2.2.1 Detailed installation steps 
1. Disable or switch off eventual anti-virus or anti-malware application that may 

bloc the installation. 
2. Run the ARCspectroRocket 3.2.0 Installation Package.exe 

 
3. The installer will verify if the requested versions of the .Net Framework and c++ 

redistributable 2015-2019 64 bits are already installed. Following message will 
be showed: 
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If not, the installer will install the redistributable C++. However, it will not be able to 
install missing .NET libraries. 

4. Follow the installations steps 
5. At the end of the installation device driver will be installed libusb-win 32 

 
6. Software in now installed 
7. Once the software and drivers are installed you may check in the device 

manager of windows if the Gasex is correctly recognize by windows (if you 
connect the USB to the computer (and switch on the device). It should be 
recognized as a libusb-win32 device. 
 
you can launch the application called ARCspectroMD.exe directly in the start 
menu of windows or via the Explorer in the program Files / Arcoptix  folder as 
shown below 
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2.3 Hardware installation details 

2.3.1 USB connection 
The FT Rocket operates via a 
USB 2.0 or higher connection. 
You need to connect the 
spectrometer to your PC 
using the USB cable supplied 
with the spectrometer. 

 

 

 

 

2.3.2 Power supply connection 
Connect the 12V power 
supply to the spectrometer. 

 

 

 

 

 

 

 

2.3.3 Optical input 
The standard connection for 
the spectrometer is a SMA-
905 fiber port. Remove the 
blue cap and screw in you 
optical fiber. 
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On the FT-IR 2-12 (and 
some customized 
systems), the fiber coupler 
is external and removable. 
This is useful if you want to 
couple a free-space 
propagating beam into the 
spectrometer. 

To remove the fiber 
coupler, you need to use a 
2.5mm Allen key. 
Untightening the 2 screws 
on the fiber coupler 
diagonal will release the 
fiber coupler. 
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2.3.4 Purge gas connection 
Some of the Arcoptix spectrometers are 
equipped with a descicant that filters out 
the water vapour and CO2 present in 
the interferometer. Since the 
spectrometer is not fully hermetic to 
gases from the outside (there is always 
some leakage), the descicant will 
saturate after a certain time (typically 
one year). The descicant is placed in a 
holder accesible from the top side of the 
spectrometer. If the descicant becomes 
saturated, water vapour and CO2 absorption lines will become more pronouced. To 
reduce the impact of those lines (that may interfer with gases the user wants to 
measure), it is recommended to repalce the descicant with a fresh one. For doing so, 
unscew the descicant cover (6 screws) and repalce it with the fresh the descicant 
(with the inscriptiions looking upwards) as showed in the picture. Finally close the 
holder again with the 6 screws. Notice that the descant saturates very quicly in an 
open environment (outside his plastic package or outside the desciant holder). The 
replacement operation has to be performed quickly (open the holder before openenin 
the desciant package). You will have to wait for a few hours before the level of water 
vapour significately reduces inside the interferometer (spectrometer). New 
Descicants can be ordered directly from Arcoptix.  
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2.4 Example measurement set-ups 
 

2.4.1 Transmission measurements 
In a setup for transmission/reflection, you will need: 

 2 fiber optical cables. Take optical fiber with large core diameter (i.e. 600 m 

to 1000 m) to assure optimal coupling condition and no loss of intensity. 
 A sample, cuvette holder or probe 
 A fiber-coupled light source  

Light from the lamp is sent via optical fibers to a sample holder (or any other sampling 
accessory). The sample transmission is collected via fiber optic and sent to the 
spectrometer, as shown in Figure 2-1: 

 

Figure 2-1 - Typical transmission measurement set-up 

The following steps have to be performed to prepare for a measurement: 

 

1. Connect the optical fiber to the lamp.  
2. Connect optical fiber to the sample holder/probe for illumination. Note that there 

are sample holders and probes that have different connections for illumination 
and measurement. 

3. Connect an optical fiber to the sample holder/probe and the spectrometer. It is 
recommended to use fibers with core diameters of at least than 500 m. 
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4. Switch on the light source. If your light source has a shutter or an attenuator, 
ensure that these are open.   

5. Connect the spectrometer via USB port to a PC with Arcspectro software 
already installed. 

6. Start the Arcspectro program. This may take several seconds because of 
initialization and calibration that have to be loaded.  

7. Start a single measurement by pressing the “Read” button .  

 

The spectrometer and its software are now operational and allow you to use all 
features described in CHAPTER 3. 

 

2.4.2 Reflection measurements 
In similar way as transmission measurements, you can perform measurements in 
reflection. A possible setup is shown below in Figure 2-2. Reflection probes are 
available by different suppliers. These reflection probes usually contain several 
illumination fibers and one analysis fiber. 

NOTE: Choose fibered optical probes with large core diameter fibers (e.g. 600µm) for 
optimal performance.  

 

Figure 2-2 - Example of a reflection measurement setup employing a fibered reflection probe 



 - 18 - 

  Arcoptix S.A.  

2.4.3 Measurement of lasers – beam power limitations 
Lasers can be measured by directly shining laser light into the spectrometer via an 
optical fiber of free-space entrance port. 

Note that pulsed lasers (or pulsed sources in general) can only be measured if their 
repetition rate is faster that the FT Rocket interferometer modulation frequencies. 
Typically, only lasers with repetition rates above 25kHz can be measured. Please 
contact Arcoptix for further information.  

Another important aspect is the beam power limitation, in order to avoid detector 
damage: 

1) The CW, average or peak power of pulses longer then 1μs must not exceed 
25mW 
 

2) The peak power of pulses shorter than 1μs must not exceed 100W 
 

3) For repeated irradiation with pulses shorter than 1 µs, the equivalent CW 
irradiation, i.e. average power over the pulse-to-pulse period should be less 
than the CW maximum power according to equation: 
 
(Equivalent CW radiation power) = 
(pulse peak power)*(pulse duration)*(repetition rate) 

Failing to respect these beam power limitations will result in loss of warranty. 
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 Arcspectro FT software 
 

3.1 General information 
 
The Arcoptix FT ROCKET spectrometer is controlled by an application program. 
Spectral data is shown in the main window which is presented when the program is 
opened, presented in Figure 3-1: 

 

Figure 3-1 – Graphical user interface of the Arcspectro application program. 

Notice that once the program is started, the spectrometer is still not connected to the 
software and measurements cannot start directly. The user should first connect the 
spectrometer to the software with the connect to spectrometer button (see below). 

It is important to understand that the software works with two executables: 

1) A “server program” called AoDAQWin-exe that will be started in background on 
the computer. You may be requested (by windows security service) to authorize 
this executable to be started. This AODAQWin will be responsible to 
communicate with the spectrometer and also to make all the required signal 
processing (as for example the Fourier transform of the raw signal). This 
AoDaqwin executable will be started in background when connecting to the 
spectrometer (as explained below). 

2) A “client program” as described in the figure above that is responsible to display 
(load, save, zoom,…) the measured spectra (preprocessed before by the 
AODAQWin executable that works in background. 

Both programs described above will communicate with a (internal to the computer) 
TC-IP connection. 
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3.1.1 General Layout of the Window 
In general, the program conforms to standard Windows conventions. For sake of 
brevity, features that are common to other windows programs (e.g. the dialog box for 
saving a spectrum is similar to that used for saving files in other programs) are not 
described. The window contains a menu bar, a toolbar and some other option bars that 
will be explained below. Above the measurement window the toolbar a line indicates 
important parameters such as the amplifier gain, resolution and the plot type.  
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3.2 Menu bars 
 

3.2.1 Connect Spectrometer 
In order to connect the software to the spectrometer we need to setup a TCp-IP 
connection. This connection can be either 

1) Internal to the computer via the address 127.0.0.1 (of the current computer) 
2) External if the device is connected to the network or directely to the computer. 

More info can be found in Annex at the end of the manual. 

In case the spectrometer is connected via USB to the computer it is the internal 
connection to the computer that we will need to set-up. 

1) Make sure that the spectrometer is connect to the computer and it is powered 
(12V). 

2) Click connect to spectrometer 

 

3) Click connect to USB Device (if it is usb connected).  
Notice that for a ethernet connected spectrometer either click search for device 
and it will give all the connected spectrometers visible on the internal network 
or enter directly the address of the device and click “connect to ethernet 
device”. 

4) Wait for a moment. There will be a server application called AoDAQWin-exe 
that will be started in background on the computer. You may be requested to 
authorize this executable to be started. This AODAQWin will be responsible to 
communicate with the spectrometer and also to make all the required signal 
processing. This application may require important CPU resources and it is 
better not have many tasks running in parallel. Also notice that a message 
“Aodaq process is already running” may appear. Just click ok it this case. 
Waiting time maybe up to 1 minute.  

5) Device connected you will see in the status bar the serial number of the device 
appearing. You can now begin the measurements. 
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3.2.2 The File Menu 
The File menu is used to access data storage and print functions. 

Open… Presents a standard 
Windows dialog box to open data. Only 
binary files with the extension 
“*.arcspectro” are accepted. The loaded 
spectra will be shown in a different color 
on the screen. To delete the most recently 

loaded spectra use the return  button. 
In the case that no baseline was 

measured with the original data the following message is shown.   

 

 

 

Save… Presents a standard Windows dialog box to save data. The file is saved 
as binary file and can be used for further data processing only with the ARCspectro 
software. It can be opened with the “Open” command. Only binary data can be saved.  
The extension is predefined as “*.arcspectro”.  All data will be saved containing all 
spectral information and a baseline. 

A path and a filename have to be chosen and the data can be saved.  

Export Displayed Spectrum to Spreadsheet… 

Allows saving data in text spreadsheet format.  

ONLY THE LAST RECORDER DATA WITH THE WAVELENGTHS RANGE AS 
SHOWN ON THE SCREEN WILL BE SAVED. 
This includes functionalities like absorption and transmission. For example, if a spectra 
that shows absorption values in a narrow spectral range is exported you will only find 
these data in text file. The output format of the TXT file is shown here below: 
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Some indications about the measurements (3 first lines) and then 3 tab separated 
columns indicating: the wavenumber in cm-1, corresponding wavelength in nm and 
displayed spectrum in A.u. 

Exported files have no extension and can be opened with conventional programs (such 
as excel) for further processing. 

 

Export Interferogram to Spreadsheet  

Allows saving interferogram data in text spreadsheet format. Exported files have no 
extension and can be opened with conventional programs (such as excel) for further 
processing. 
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3.2.3 The Tools Menu 
The Tools menu allows the user to access the Sequence measurement function. It 
gives the possibility to perform and analyze time series measurement. Two submenus 
are available. Sequence measurement and Sequence viewer. Please  

    

Please refer to section 4.3.4  below in the manuel for further details about sequence 
measurements. 

3.2.4 Measure options 
These are advanced features, they are discussed in chapter 4.3 . 

 

3.2.5 Help 
Opens a window that provides information of the software version.  
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3.3 Tools Bar 
 

 

Open spectrum - Presents a standard Windows dialog box to load 
already saved data that were saved as binary files. Several graphs can 
be loaded and shown in different colors on the screen.  

 

Save Graphic - Presents a standard Windows dialog box to save the 
active graph. Saved data represents all information with complete 
spectral range and baseline. Data are saved in binary format. For text 
format please EXPORT… data. 

 

Remove last loaded spectrum - Remove spectral data in the graph 
from the screen in the order of loading. The most recently loaded graph 
is removed first.  

 

Read - Starts a measurement. The button appears grey if the 
measurement is in progress.  

 

Read continuously - Collected spectra on a repetitive basis. Data 
collection is initiated upon selecting this option, and is terminated by 
pressing the button again.   

 

Set baseline spectrum – Sets the current measurement as baseline 
(reference) measurement and stores it for further treatment in local 
buffer. This operation has to be done before transmission or absorption 
measurements can be evaluated.  

 

Set dark spectrum - Sets the current measurement as dark (no light ) 
measurement and stores it for further treatment in local buffer. This is 
useful when a constant background is present and needs to be removed. 
The dark substraction also has to be activated, see Chapter 4.3.2  

 

Spectrum - Sets the measurement modus in spectra mode and shows 
the raw spectral data recorded by the spectrometer.  

 

Absorption - Sets the measurement modus in absorption mode and 

shows the absorption relative to a white baseline measurement  that 
has to be done before.  

 

Transmission - Sets the measurement modus in transmission mode 

and shows the transmission relative to a baseline measurement  that 
has to be done before. 

 

Zoom Tool - Allows manual scaling by click and drag. Double click in the 

measurement window performs a autoscale  
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Move graph - On activating the graph can be moved laterally. 

 

Autoscale - Expands/contracts the vertical axis so that the minimum and 
maximum intensity and spectral range of the spectrum are at the 
minimum and maximum of the plot. Is also performed when the active 
window is double clicked. 

 

Show interferogram - Shows the raw data of the interferogram recorded 
by the device. The data are plotted against the optical path difference 
OPD.  

 

Cursor toolbar - Opens a courser toolbar at the bottom of the window. 
Please see the detailed explanation below.  

 

Graphing options - Opens a graphing options window at the right of the 
window. Please see the detailed explanation below. 

 

NOTE: If you are collecting data on a continuous basis or on a timed basis, some of 
the buttons are not active.  
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3.4 Options Bars 
 

Detection gain Shows the amplification 
setting of the detector electronics. Four values can 
be chosen: Low, Medium, High, Extreme  

 

 

  

 

 

Scans to average Several scans can be 
averaged using this option, e.g. in order to reduce 
measurement noise. The acquisition can be 

stopped by pressing the  button. 

 

 

Domain plot Determines whether the x-axis scale 
is given in Wave-number (cm-1) or Wavelength 
(nm). 

 

 

  



 - 29 - 

  Arcoptix S.A.  

3.5 Status bars 
 

On the lower left part of the console is an Acquisition Progress indicator.  

 

 

On the lower right part of the console is a Detector Saturation indicator. It gives 
information on the signal level. If the indicator turns red the detector is saturated and 
the detector gain level or the light intensity have to be lowered.  

Optimal signal levels: 

 

The signal level varies between 100% and 10% 

 

Saturation:  

 

Either the detection gain should be decreased of or light level should be reduced.  

 

Signal level is too low: 

 

Detection gain or light intensity should be increased for optimal measurement 
performance. 

If the Detection gain is changed, a click can be heard from the instrument, confirming 
that the operation was successful. 

 

At the left of the bottom line the serial number of the actually used system is indicated. 
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3.6 Cursor Toolbar 
 

The cursor toolbar allows showing cursors on the screen to compare measurement 
results and determine points of special interest. Cursors can be moved by click and 
drag either on the cursor position or on the lines that guide the eye. Cursors can be 
added and removed only when acquisition is switched off. Cursors stay visible when a 
new acquisition cycle is started. Values of actual cursor positions are shown. The 
screenshot below gives you and impression of the functionality. 

 

Figure 3-2 - Sample measurement with cursor toolbar and two cursors. The cursors can be moved 
by click and drag. 

 

The cursor toolbar below the measurement window has the following buttons: 

 

Add Cursor – Activates a new curser.  

 
Remove Cursor – Re moves most recently activated curser 

 
Remove Cursors – Removes all cursers 

 

Note:  Cursers cannot be moved when Zoom or Moving option are activated. Please 
deactivate this function to move cursers.  
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3.7 Graphing options 

If you push the graphing option button  a side menu becomes visible on the right 
that allows you to change your graphing. There are four levels: 

 

Graph    Plot   Zoom   Colors 

      

 

3.7.1 Graph 
The graph submenu allows you to choose grids and to set linear or logarithmic scales. 

 

None - Removes the grid from the graph 

 

Major - Set a major grid.  

 

Minor - Set a minor grid. 

 

The axis check boxes for x and y axis scale gives you the possibility to set the axis 
scale to predefined values (linear or logarithmic). 

 

3.7.2 Plot 
The plot submenu gives you the possibility to show the data points and to choose a 
convenient point size. In samples box you can switch on and off the sampling points 
and chose their point size.  



 - 32 - 

  Arcoptix S.A.  

3.7.3 Zoom on axis 

The following functionality has to be used together with the zoom button .  

 

 

When checked allows zoom in both axes. 

 

When checked allows zoom only in x axis 

 

When checked allows zoom only in y axis 

 

The axis range can be set completely manually. In the box shown below axis 
parameters have to be given. Depending on the either wavenumber or a wavelength 
is chosen as “Domain Plot” option the values have to be wavenumber [per cm] or 
wavelengths [nm].  

 

 

Please press update to activate new numbers. 

 

3.7.4 Colors 
Color submenu allows changing background color, plot color and line width for the 
screen. There are predefined values from which one can choose through scroll down 
menus.  
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  Measuring with the Arcspectro FT Rocket  
 

4.1 Overview 
The Arcoptix FT Rocket spectrometer is typically used to measure transmission 
spectra using a cuvette and a sample holder. This chapter describes the general 
approach to collecting data and presents a series of suggestions to optimize the quality 
of measurement. Since the spectrometer can measure the spectrum of a broad range 
of samples in a large number of applications, the information presented in this chapter 
is somewhat general in nature. The analyst will likely find specific information about 
sampling and collecting spectra for the specific sample in the general scientific 
literature.  

A cuvette and a sample holder are used when the spectrum of a liquid is to be obtained. 
The standard cuvette has a 1 cm path length (although other lengths may be used) 
and requires approximately 2 mL of sample. If the available sample is less than 2 mL, 
a number of smaller cuvettes are available and an adapter can be used to reproducibly 
position the cuvette. 

NOTE: It should be noted that the absorbance of a sample is proportional to path 
length, and using a thinner cuvette will be beneficial for samples with large absorbance 
values.  

The cuvette is an integral part of the optical system, and should be handled with care. 
The following points should be noted to ensure the fidelity of collected spectra:  

 In case of a transmission measurement with cuvettes: always place the cuvette 
in the light path so that the same wall plane faces the incoming light to ensure 
a constant path length.  

 Do not get fingerprints on the optical faces of the cuvette. If you accidentally 
touch an optical surface, wipe it off with a lint free tissue saturated with 
methanol and allow the methanol to evaporate. 

 If an optical surface of the cuvette is scratched, chipped or becomes cloudy, 
position the cuvette in the sample holder so that the light does not go through 
that surface. 

 The sample should be dissolved in a suitable solvent and should be 
homogeneous. Spectroscopic grade or other highly purified solvents should be 
used whenever possible. If the source of the solvent is changed, verify that the 
new solvent and the old solvent are equivalent and collect a new background 
spectrum. If the sample contains particulate matter, make sure that it is filtered 
to remove the solid material. If there are air bubbles in the sample, remove 
them before taking a measurement. Air bubbles are occasionally observed in 
aqueous samples that have been allowed to sit undisturbed for a period of time. 
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4.2 To collect a spectrum 
 

Install the hardware system correctly by connecting fibers properly and switch on the 
source. Connect the spectrometer and start the software. Adjust the intensity and the 
detection gain to operate in the optimal range. A Halogen lamp of sufficient power is 

recommended for operation. Click on “Read”  to start an acquisition. Figure 4-1 
below shows you a sample measurement in the wavelengths domain. Data are 
collected in 2.5s, but the measurement takes typically 1.5s more because of additional 

signal processing that has to be performed. If the option “show interferogram”  is 
activated, the interferogram related to the spectra is also shown. 

 

Figure 4-1 - Spectrum and corresponding interferogram (IGM) 

 

After a measurement has been performed the scale in the graph can be eventually 

arranged. To do so, press the Auto-Scale  button.  

 

To get access to functionalities like absorption and transmission measurements, you 
need to measure a reference spectrum. Place a reference sample (it is often just an 
empty cuvette) in the sample holder and collect the background (baseline) spectrum. 

To do so, perform a measurement with “Read”   and then press the “Set baseline 

spectrum” button . The following functions get accessible (highlighted):  

Spectrum,  Transmission,  Absorption. 
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Measure the reference sample again in transmission mode ( ).  The result will be a 
transmission value of 1, apart from measurement noise, all over the usable wavelength 
range, as shown in Fig. 4 - 4 below. 

 

Figure 4-2 – Checking the noise level in the baseline 

 

NOTE: If appropriate, the background spectrum can be taken using an empty cuvette. 

 

The spectrum of a standard should be collected on a periodic basis (in many 
laboratories, a sheet of a polymer is employed as a standard). The standard should 
have a number of absorbance bands spread across the spectral region. When the 
spectrum of a standard is collected, the analyst should check that the intensity of the 
bands and the wavelength remains constant over time. 
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4.3 Advanced Features – Measure Options Menu 
 

The software offers some advanced options that are both accessible using the 
Measure Options Menu. Before using these options, make sure that you understand 
what they do by reading the following paragraphs. 

 

 

 

4.3.1 Interferogram apodization 
The spectrum that is produced by the software is, by default, produced by Fourier 
transformation of the unapodized interferogram (None). 

This Interferogram Apodization option allows you to apply a Weak, Medium or Strong 
Norton-Beer type apodization (and some others) to the interferogram before the 
Fourier transformation. The main effect of Interferogram Apodization is to smooth the 
spectrum. It can also eliminate ripple effect on the spectra. Finally, it may also enhance 
the linearity of absorption measurements if narrow bands are present such as in gases. 

Generally, we recommend to work with Norton-Beer weak apodization. 

 

As for the Interferogram Averaging, a clear and visible interferogram center burst must 
be available for the method to operate effectively. When measuring very weak signals 
or narrow spectra, set the apodization to None. 
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4.3.2 Dark Substration 
One particular advantage of Fourier-transform spectrometers over dispersive 
instruments is that detector dark current signal is not producing any dark (offset) 
spectrum. This is because only the AC components of the detector signal (the 
interferogram) are carrying spectral information. 

In certain specific situations, a dark background signal may be present. In this case 
background subtraction may be needed. For example, when connecting an internally 
illuminated integrating sphere, some light is sent to the spectrometer even when no 
sample is placed on the measurement port, as shown on Figure 3 - Dark signal 
measured with an internally illuminated integration sphere 

 

Figure 3 - Dark signal measured with an internally illuminated integration sphere 

Press the Dark Reference button to store this measurement as the dark 
spectrum. Then go into the Measure Options menu and activate the Dark 
Substraction option. The software will now substract the Dark Spectrum from the next 
measured spectra 
You can now proceed as usually by measuring the (white) baseline reference spectrum 
and then switch to any measurement mode (transmission, absorption). 

 

4.3.3 Irradiance calibration 
The Arcspectro software disposes of an interface for calibrating the spectrometer for 
irradiance measurements. In order to perform such an irradiance calibration, the user 
needs: 

 A calibrated light source 
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 A data file containing the irradiance values of the calibrated light source at 
wavelengths between 900 and 2600nm (or the equivalent wavenumbers). 

  

Connect the calibrated light source to the spectrometer and tune the light intensity and 
gain level to obtain a satisfying signal level. 

 

NOTE: performing averaging (either by spectrum or interferogram averaging) in this 
measurement is strongly advised to reduce noise, as noise in the light source 
measurement will propagate as fixed pattern noise to subsequent irradiance 
measurements. 

In the Advanced menu, select Prepare Irradiance Functions: 

 

This will open a new window interface helping you to prepare irradiance data: 
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The upper part of the window, Wavenumber/Wavelength vectors, allows you to 
generate text-format files with the internal Wavenumber (or Wavelength) grid, while 
the lower part , Irradiance Reference, allows you to load data into the system. 

The calibration procedure can be realized either in wavenumbers or in wavelengths. 
Pressing the Wavenumbers button in the Prepare Irradiance Function window will open 
a dialog to save a file: 

 

 

The content of the file are wavenumbers in the units of [cm-1]: 
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Note that a similar file can be generated with wavelengths in the units of [nm] by 
pressing the Wavelengthss button in the Prepare Irradiance Function window. 

NOTE: due to the Fourier-transform functioning principle of the Arcspectro FT 
ROCKET, the generated wavenumber vector is equally spaced but the wavelengths 
vector is not. 

  

In order to calibrate the spectrometer for irradiance measurements, the user needs to 
interpolate irradiance data from the calibrated light source data file onto the 
wavenumber (or wavelength) vector in the file just generated, with the help of an 
external program (e.g. EXCEL or MATLAB). Then a text file must be generated with 
two-columns [Wavenumber Irradiance] separated by a tab character as in the 
following example: 

 



 - 42 - 

  Arcoptix S.A.  

Once the two-columns text file is ready, go back to the Prepare Irradiance Function 
window and press the Load Ref – wavenumbers button (or Load Ref – wavelengths 
button if you prepared a reference file based on wavelengths). 

 

In our example, we prepared a two-column file called 
BlackBody3450K_Wavenumbers.txt : 

 

Choose the file and press Open. 

Once the file is loaded, you are allowed to press the OK button to validate the 
calibration: 
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IMPORTANT NOTE: interpolating the irradiance data onto the spectrometer 
wavenumber (or wavelength) vector is NOT made internally by the Arcspectro 
software, as this procedure may differ depending on the resolution of the irradiance 
data file thus requiring expertise by the user. 

If you try to load a file with wavenumbers (or wavelengths) differing from the required 
ones, the system will display the following error: 

 

If this happens, check the format of your file and the wavenumbers (wavelengths) data 
and try loading it again. 

Back in the main GUI window, a new button  will appear in the Tools bar. Click on 
it to display irradiance values. 

 

Now you can perform irradiance measurements by pressing the read button . 

 

Saving and reloading Irradiance calibration files 

Once you have completed the irradiance calibration, the result can be saved and 
reloaded for further use. To save calibration data, select Save Irradiance Transform to 
File in the Advanced Menu:  
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This will open a dialog window for saving the calibration in a *.itans file. 

 

 

To reload the calibration, select Load Irradiance Transform from File in the Advanced 
Menu: 

 

 

NOTE: Modifying the coupling optics from the light source to the spectrometer (e.g. 
changing the fiber or focusing optics) is likely to alter the spectrum entering the 
spectrometer, thus invalidating the irradiance calibration. 
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4.3.4 Sequence measurement  
The Arcspectro software allows you to save a time-series (sequence) of 
measurements. To keep operation flexible, the feature allows saving data in two 
different formats. The functionality is accessed via the Tool menu that allows opening 
two windows.  

 

Sequence measurement allows choosing the total number of measurements, the delay 
between measurements and a sequence name. “Sequence pause” can be given in 
milliseconds (msec), seconds (sec), minutes (min) and hours.  

 

NOTE: The acquisition time is not counted in the “sequence pause” parameter. You 
will add the measurement time (which depends of the computer and resolution of the 
device). 

 

The save format scroll down menu gives to options for saving: Binary Format or text 
format. If you want to use the data outside the measurement program for further 
processing you should use the option Spreadsheet-text format.  

A box in the save format area allows you save the first dataset as baseline. If not 

checked the internal reference as set before by the baseline measurement button  
will be saved with the data.   

You have to give a sequence name and specify the path where the date should be 
saved. There will be an automatic numbering of the file names. If text format is used, 
the time when the measurement was performed is part of the file name and all data 
are saved in text format that can be read with compatible programs like EXCEL or 
MATLAB.  
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If a sequence is saved in binary format it will be available for further processing. 
Choosing in the Tools menu the option Sequence viewer opens a standard Windows 
dialog box that allows you to load a sequence. Note, only binary data can be loaded. 
Choose your measurement sequence and confirm with OK. The data will be shown in 
the active window. It might be necessary to rescale the graph. At the same moment, 
the following screen will appear. It gives an overview over the recorded sequence and 
allows saving selected data into spreadsheets via a scroll down menu.  

 

 

The spectrums are listed in the box at the left side of the Viewer Window. The upper 
right side displays some relevant sequence information and the lower right side shows 
signal-specific information. 

Use the Open option in the Sequence menu to open a new sequence. The Clear option 
of the same menu clears all the displayed sequence spectrums. 

You can export a selected signal to a spreadsheet format using the Export Selected 
Signal to Spreadsheet option of the Export Signal menu.  

Finally you can display an average of the sequence spectrums by checking the Plot 
Average option in the Statistics menu. The average spectrum will be displayed on top 
of the sequence signals with yellow squares. The following figure illustrates 10 
consecutive measurements of a 1500nm long-pass filter. 
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Creating a Matrix of measurements from files 

It is possible to make a txt file where a group of selected measurement are 
concatenated together in a tab separate txt file. Such files may be used for importing 
the measurements in a separate third-party analysis program. 

First, select the Create Matrix from files… option in the Tools menu. 

 

This option brings up the following dialog box. 

 

You can add the signals you want to export using the Add Signal button. You can keep 
the dialog box open as you make a measurement then add the resulting signal, make 
another measurement, add it and so on. You can always select and view a signal 
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before saving the matrix to a file (using the Save File button) and you can also delete 
a selected signal or clear the whole list using either the Remove Signal or Clear all 
Signals buttons. 

This is what the dialog box looks like after having added 3 signals: 

 

 

You can select the signals using the left-sided list box. Doing so shows a preview of 
the signal in shown in the graph. You can change its name in the Name (Line name) 
textbox if so desired. 

When all the desired measurements are loaded in the list, you can press the save 
button and save all the measurement together in a tab separated matrix. The saved 
file is a TXT format file as shown here below: 

 

First column is the wavenumber and the following columns are the measurement 
“Measure1, “measure2”, “measure3”,…. 

This Txt file may be handy for exporting your measurement results to another program 
for analysis. 
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4.3.5 Device status 
 

The device status window permits to have an overview of the general hardware status 
and parameters of the device: 

 

- Laser TEC Alarm: indicates if the temperature of internal control laser is on 
target 

- Detector TEC Alarm: indicates if the temperature of the detector is on target. 
- Source Alarm Status: indicates if the source is ok (or maybe broken) (if 

installed) 
- Scanning Status: indicates whether the interferometer is scanning correctly 
- Laser mean Level: indicates the intensity level of the control laser 
- Device, Drive and AoDAQ versions number indicates which versions of drivers 

and software is installed in the device. 
- Device temperature indicates the temperature on the electronic board next to 

the interferometer (should not exceed 50 °C) 
- Source voltage: Voltage on the source ( if installed) 
- Source Temp: temperature of the source electronic board. 

Notice that the values indicated are sometimes misleading and not always useful. This 
is mainly for servicing purposes and sometimes debugging or repairing purposes. 

 

4.4 Quantitative Measurements 
 

The transmission (T) of a sample is defined by: 

𝑇 =
𝐼

𝐼௢
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where 𝐼 is the power of the light that is transmitted by the sample, 𝐼௢ is the power of 
the light incident on the sample. 

 

The absorbance (𝐴) of a sample is the logarithm (base 10) of the reciprocal of the 
transmittance: 

𝐴 = −10𝑙𝑜𝑔ଵ଴𝑇 = 10𝑙𝑜𝑔ଵ଴

1

𝑇
  

    

Beer’s Law, can be used to determine the concentration of the compound of interest. 

𝐴 = 𝑎𝑐𝐿 

where: 𝐴 is the absorbance, 𝑎 is the molar absorbance coefficient, which is a constant 
for a compound in a given solvent at a given temperature, 𝑐 is the concentration of the 
compound 𝐿 is the sample thickness. 
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  Troubleshooting 
 

5.1 Sample Related Spectra Issue 
If the instrument appears to be working in an acceptable manner (e.g. the spectra of 
the standard is acceptable) and unacceptable sample spectra are obtained, it is 
probable that the difficulty is related to the sample. Typical sample related issues are 
indicated in the following Table: 

Sample Related Issues 

Problem Cause Solution 

 

The absorbance is weak 
or % T is very high (noisy 
spectrum) 

The sample is too thin or 
too much light is lost 

In transmission use thicker 
samples 

Increase the number of 
averages in order to 
increase the SNR 

The absorbance is too 
strong or % T is near zero 

The sample is too 
concentrated or thick 

Dilute the sample or use a 
thinner sample. 
Sometimes an ATR 
measurement may help 
(low penetration). 

Intensity of peaks or 
signal vary in time.  

Sample variation 
(evaporation) or 
temperature variations. 
Fiber vibrations or 
displacement, 

 

Control the temperature or 
make baseline and sample 
measurement as close as 
possible in time. Control 
that vibrations are not 
present (like ventilator 
running on the table) 

Reproducibility Temperature variation, 
Sample variation, setup 
variation (particularly with 
fibers) 

Variation of a percent are 
common when doing 
spectroscopy. 

 

 

5.2 General troubleshooting 
Since the Arcspectro FT ROCKET is employed in a system that includes a light source, 
a sample probe and a sample, all troubleshooting activities should include all 
components of the system. Troubleshooting can be simplified by a consideration of the 
following guidelines. 
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In principle the light source can easily be check by bear eye. Sample probe and sample 
can be the cause of the problem but the variety of samples and measurement methods 
are so large that we will not discuss this here. 

First of all, as for many device, a switch off and switch on followed by a restart may 
solve the problem. Also some software bugs that are related a to a particular 
combination of operations are not excluded. If an error message is presented, press 
the Continue button indicated on the Error Message dialog box. If this does not 
remedy the problem, turn off the spectrometer, disconnect the USB cable, reconnect 
and restart the software. 

If the error persists (and you can still connect to the spectrometer, you may have a 
look at the device status windows (see in the manual). Alarms (first 3 items in the list) 
should be false, Scanning Status value should be true, Laser mean level around 10 
Exp 7 (however this value is variable from device to device and may be also at 10 Exp 
6), Device Temp (below 60°). Other values are not relevant for all devices. 

Run a standard (or a series of standards) on a periodic basis to verify that the system 
is performing properly. When abnormal data is obtained, collect the spectrum of a 
standard and compare the spectrum to one that was previously obtained. 

. 
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Symptom Cause Solution & Checks 

 

Cannot connect (offline) USB cable is loose, 
Reset port problem, 
Driver problem 
spectrometer problem. 
AODaqwin.exe server 
did not start in 
background 

Check cables for good 
contact. Rest the computer 
(sometimes for portables 
remove the battery a few 
seconds). Check driver in 
device manager. Check in 
Task manager in the 
AOdaqwin.exe serveur is 
starting in bakground 

No signal or only noise Problem with setup 
(make a standard 
measurement). Problem 
with light source, 
problem with the 
detector or internal 
control laser 

Make a simple standard 
measurement where all the 
other parameters are sure 
and known. Check lase 
level in device params. 
Restart software, 
spectrometer and 
computer. 

A lot of variation or drift in 
the signal 

Thermocooler defect, or 
internal control laser. 
Setup problem. 
interferometer 
misaligned. 

Check Alarms in the device 
status. Check 
reproducibility with a 
simple setup. 

Wavelength Shift In principle not possible Contact arcoptix 

Strange signal Detector saturated or not 
enough signal. Defect 
laser. Or interferometer 
misaligned. 

Contact Arcoptix or its local 
representative. Check with 
a simple setup the results. 

Strong water vapor lines desiccant saturated Replace desiccant. 
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Appendix 1 – Dimensions 
 

FT-NIR & FT-MIR (fiber input) 
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Appendix 2 – Installation 
 

Use the provided installer file “ARCspectroRocket 3.X.Y Installation Package.exe” to 
install the new software. The installer will also install the USBLIB driver. 

Once the software installation is complete, re-connect the spectrometer and open the 
Device Manager to check if the “ARCspectro ANIR-MD” is properly recognized as 
“libusb-win32 devices” as shown below. 

 

 

 

Now you can start the new ARCspectro Rocket software to control the spectrometer. 

 


